
    



Welcome to AIFrontDesk Pro 

 

Get Started 

Build Your First AI Call Agent in 5 Minutes 
Step-by-step guide to create, test, and deploy your first AI call agent with AIFrontDesk 
Pro 

Overview 
AIFrontDesk Pro is a platform for building, testing, and deploying intelligent AI call agents that 
can handle natural, human-like conversations with your customers.  

This quickstart guide will walk you through: 

●​ Choosing your plan and starting a free trial 
●​ Submitting your business and knowledge base information 
●​ Creating and testing your first AI agent 
●​ Deploying it to a real phone number 
●​ Making your first AI-powered call​

 

 



Step 1: Choose a Plan and Start Your Free Trial 
1.​ Go to AIFrontDesk Pro Pricing & Plans 
2.​ Choose the plan that fits your needs (e.g., AI Call Agent – Starter) 
3.​ Click Start Free Trial to begin the setup process​

 

You’ll then see a registration form like this: 

 

Fill in all required fields: 

●​ First Name / Last Name – Your personal or business contact name 
●​ Select the Service – Choose the AI Call Agent plan you want (e.g., Starter, Pro, or 

Enterprise) 
●​ Username – Create a unique username for your dashboard login 
●​ Email – Used for login and notifications 
●​ Password / Confirm Password – Set a secure password 
●​ Website URL – Your business website (used to build your agent’s knowledge base) 
●​ Upload File – Optionally upload PDFs, FAQs, or manuals to help train your AI agent​

 

Once completed, click Sign In to submit your setup details. 

https://aifrontdesk.co/prices-and-plans/


💡 Tip: The uploaded files and your website URL are used to teach your AI agent 
about your products, services, and business tone. 

 

Step 2: Create a New Agent 
1.​ From the main dashboard, navigate to the Agents tab 
2.​ Click Create New Agent 
3.​ Select “Voice Agent” as the agent type 

 

4.​ Choose a template that matches your business type or use case 

 

5.​ Configure your agent settings and prompts 
6.​ Name your agent and add an optional description 

💡 Tip: Templates come preloaded with conversation flows and intents to help you 
get started fast. 

 
 



Step 3: Test Your Agent 
1.​ Click the Test button on your agent’s page 
2.​ Use the built-in web call simulator to interact with your AI agent in real time 

 

3.​ Adjust your prompts, tone, or logic based on the results 

🧠 Your AI agent learns dynamically from your settings — tweak and test until you 
get the perfect conversation style. 

 

Step 4: Add Your Payment Method 
Before purchasing or assigning a phone number, you’ll need to add a payment method. 

1.​ Go to the Billing tab 
2.​ Click Manage Payment Methods 

 



3.​ Add your preferred credit or debit card 

🔒 All payments are securely processed through our verified payment partner. 

Step 5: Deploy to a Phone Number 
1.​ Navigate to the Phone Numbers tab 
2.​ Click Buy New Number 
3.​ (Optional) Enter an area code to search for local numbers 
4.​ Purchase your number 
5.​ Assign your AI agent to the number under Number Settings​

 

🌍 You can also connect an existing business number through our integration 
options. (Twilio - via SIP trunking) 

Step 6: Test Your Phone Agent 

For Incoming Calls: 

1.​ Dial your purchased number 
2.​ Speak naturally — your AI agent will handle the call​

 

For Outbound Calls: 

1.​ Click Make an Outbound Call 
2.​ Enter a valid number with the country code (e.g., +14155552671) 
3.​ Monitor the conversation through your Live Call Dashboard 

Step 7: Connecting Your Calendar via Cal.com for 
Appointment Scheduling  
 

1.​ Create a Cal.com Account   
 ​ - Visit [Cal.com] and sign up using your preferred email address. 

http://cal.com
http://cal.com


2.​ Verify Your Email   
- After signing up, check your inbox for a verification email from Cal.com.   
- Click the verification link to activate your account. 

 
3.​ Log In to Cal.com   

- Once verified, go to [Cal.com] and sign in using your credentials. 
 

4.​ Go to Calendar Settings   
- Click on your profile or settings icon.   
- Navigate to Settings → Calendars. 
 

 
 

5.​ Connect Outlook Calendar   
- In the Calendar Apps section, find Outlook Calendar.   
- Click Details, then click Install App. 

http://cal.com


 

 

 
 

6.​ Authorize Access   
- You’ll be redirected to Microsoft’s login page.   
 - Log in with your Outlook account and grant permission for Cal.com to access 
your calendar. 

 
7.​ Integration Complete   

- Once authorized, your Outlook calendar will be synced with your Cal.com 
account.   
- You can now use it for scheduling and availability management. 

🎉 Congratulations! Your AIFrontDesk Pro agent is now live and ready to: 

●​ Receive and handle incoming calls 
●​ Make outbound calls 
●​ Engage in natural, dynamic conversations 
●​ Work 24/7 without supervision 
●​ Schedule Appointments using the connected calendar 



Build 

Setup Conversation Flow Agent 

Conversation Flow Overview 
Conversation Flow Agents structure AI call logic using nodes and transitions for complex, 
predictable interactions. 

Benefits 

●​ Structured & predictable dialogues 
●​ Handles conditional branching 
●​ Node-level fine-tuning for precision​

 

Core Components 

●​ Global Settings: Voice, language, persona, parameters 
●​ Nodes: Units of interaction (dialogue, logic, or function) 
●​ Edges: Define transitions between nodes 
●​ Functions: Reusable APIs or actions​

 

How It Works 

Each node defines specific logic. When a transition condition is met, the agent moves to the 
next node. Though setup takes longer, it ensures better control and stability. 

⚙️ Step 1: Configure Global Settings 
Access via the empty canvas → Settings. 

Key Configurations 

●​ Voice & Language: Choose or add voices (ElevenLabs), select single/multi-language 
modes. 

●​ LLM Model: Assign globally or per node (recommended: GPT-4.1). 
●​ Prompt & Persona: Define global identity and tone. 
●​ Knowledge Base: Add documents/URLs for domain context. 



●​ Speech Behavior: Adjust responsiveness, backchanneling, interruption tolerance, and 
pronunciation. 

●​ Call Controls: Handle voicemails, silence timeout, call duration, etc. 
●​ Privacy/Webhooks: Manage data policies and event delivery. 
●​ Who Speaks First: Choose whether the agent or caller starts.​

 

🧱 Step 2: Add Nodes 
Nodes are modular units controlling dialogue and logic. 

Node Types 

●​ Conversation Nodes: Dialogue handling and small talk. 
●​ Function Nodes: Trigger APIs or custom logic. 
●​ Call Control Nodes: Manage call transfers, DTMF tones, or endings. 
●​ Logic Nodes: Split flows based on conditions. 
●​ Action Nodes: Send SMS or extract variables. 
●​ Agent Transfer Node: Switch between agents while maintaining context. 
●​ MCP Node: Call MCP tools from your MCP server.​

 

Node Setup 

1.​ Select node type and add it to the canvas. 
2.​ Configure node behavior (prompt, model, logic). 
3.​ Add transition edges. 
4.​ Use Organize to auto-arrange nodes.​

 

Conversation Node 

For natural multi-turn dialogue. 

●​ Supports static or dynamic prompts. 
●​ Skip Response: Moves automatically to next node after speaking. 
●​ Global Node: Accessible anywhere. 
●​ Fine-tuning: Add conversation examples to improve accuracy. 

Function Node 

Executes predefined or custom functions. 

●​ Configure “Speak During Execution” or “Wait for Result.” 



●​ Follow with a conversation node to explain results. 
●​ Supports HTTP (GET, POST, etc.), headers, parameters, and responses.​

 

Custom Functions 

Create integrations with APIs. 

●​ Add endpoint URL, headers, and query parameters. 
●​ Define parameters via JSON schema. 
●​ Extract and store response data as dynamic variables. 
●​ Secure calls via X-Retell-Signature verification.​

 

Built-in Integrations 

●​ Check Calendar Availability / Book Calendar via Cal.com (API Key + Event Type ID).​
 

Call Transfer Node 

Transfers active calls (cold/warm transfer). 

●​ Configure destination number or SIP URI. 
●​ Options: Caller ID display, whisper messages, on-hold music, and human detection.​

 

Press Digit Node 

Automates IVR keypress navigation. 

●​ Define when to press digits, detection delay, and transition outcomes.​
 

End Node 

Terminates the call. 

●​ Add a conversation node before it for a closing message. 

Logic Split Node 

Branches conversation instantly based on variable conditions. 

●​ Include an “Else” fallback route.​
 



SMS Node 

Sends one-way SMS during phone calls. 

●​ Works only with SMS-enabled numbers. 
●​ Can use static or dynamic content.​

 

Extract Dynamic Variable Node 

Captures values (text, number, enum, boolean) from dialogue for logic use. 

Agent Transfer Node 

Transfers conversation to another AI agent (faster and context-preserving than call transfer). 

MCP Node 

Executes tools on your MCP Server, optionally with headers, parameters, and variable 
extraction. 

 

🔁 Step 3: Add Transition Conditions 
Rules that define when and where the flow moves next. 

Types 

●​ Prompt: LLM-based interpretation of user intent. 
●​ Equation: Logic-based (e.g., {{user_age}} > 18).​

 

Order: Equations → Prompts → First True triggers transition. 

Where Used: Conversation, Function, Press Digit, and Global Nodes. 

Good Practice: 

●​ Keep conditions simple and distinct.​
 

●​ Test using dynamic variables and fine-tune examples.​
 



⚙️ Advanced Features 

Global Node 

Used for universal interruptions (e.g., “Call back later”). 

●​ Works from anywhere without explicit graph connections.​
 

Finetune Examples 

Improve LLM performance by adding real conversation transcripts. 

●​ Conversation Nodes: Improve responses. 
●​ Function Nodes: Improve transition accuracy.​

 

🧭 Debug Guide 

Common Issues & Fixes 

1.​ Agent ignores instructions​
 

○​ Split long nodes. 
○​ Use a higher-capability model. 
○​ Add fine-tune examples. 
○​ Adjust temperature for consistency.​

 
2.​ Transitions fail​

 
○​ Review or simplify conditions. 
○​ Add transition fine-tune examples. 
○​ Use global nodes for fallbacks.​

 
3.​ Flow mismatch​

 
○​ Add flexible global nodes for skipping or non-linear flows. 

 
 
 



Setup Single/Multi Prompt Agent 
Choose between single or multi-prompt structures to balance simplicity and control. 

Introduction 
AIFront Desk Pro supports two prompt-based ways to build conversational phone agents. Pick 
the approach that fits your flow complexity and team needs. 

 

Agent Architecture Options 
1) Single Prompt (one prompt drives everything)​
 2) Multi-Prompt (tree of focused prompts/states) 

When to use a Single Prompt 

A single, comprehensive prompt defines persona, guardrails, and task. 

Best for 

●​ Simple, linear conversations 
●​ Prototypes and quick tests 
●​ Up to ~3 functions/tools 
●​ Minimal branching​

 

 



Limits as you scale 

●​ Behavioral drift in edge cases 
●​ Tool use becomes unreliable with many functions 
●​ Large prompts are hard to debug/maintain 
●​ Weaker state/step tracking​

 

Upgrade signal: if your prompt exceeds ~500 words or needs >3 functions, move to 
multi-prompt. 

 

Why choose Multi-Prompt (recommended for real apps) 

Organize the conversation as states. Each state has its own prompt, allowed tools, and 
transition rules. 

Per-state features 

●​ Focused prompt for that phase 
●​ State-specific functions only 
●​ Clear transition conditions 
●​ Context variables passed forward​

 

Example – Lead Qualification 

●​ State 1: Qualify (collect info; no booking tools available) 
●​ State 2: Schedule (enabled only after qualification; booking tools available; uses prior 

context)​
 

 



Benefits 

1.​ Predictable behavior per state 
2.​ Easier debugging (issues isolated) 
3.​ Safer tool control (only what’s needed is allowed) 
4.​ Scales by adding states without breaking others 
5.​ Parallelizable teamwork (different owners per state)​

 

 

Step 1 — Write a Single Prompt (if using the 
single-prompt route) 
Prompt engineering can make or break an agent. Structure your system prompt so the model 
can parse and follow it reliably. 

A. Use “sectional prompts” 

Break the prompt into small, labeled sections: 

●​ Identity – who the agent is 
●​ Style guardrails – tone, concision, safety notes 
●​ Response guidelines – formatting/constraints (e.g., speak dates naturally; ask one 

question at a time) 
●​ Task & goals – exactly what to do​

 

 



Example skeleton (paste into your prompt editor): 

## Identity 
You are a friendly AI assistant for AIFrontDesk Pro. ... 
## Style Guardrails 
Be concise: ... 
Be conversational: ... 
... 
## Response Guidelines 
Return dates in spoken form: ... 
Ask up to one question at a time: ... 
... 
## Task 
1. Greet the user. 
... 

B. Write the task as steps 

Spell out the procedure you want the agent to follow. Use numbered steps and small bits of 
logic. 

## Task 
1. Ask for the user's name. 
2. Ask if the user needs a refund, a replacement, or just information. 
   - if refund -> transition to refund state 
   - if replacement -> transition to replacement state 
3. If information only -> ask for order number. 

If the agent rushes, explicitly add “wait for user response” between steps: 

1. Inform the user why you’re calling. 
2. Ask for the user's name. 
wait for user response 
3. Ask whether refund / replacement / information. 
wait for user response 
... 

 



Build a Multi-Prompt Agent (state machine approach) 

 

1) Break the conversation into steps (states) 
Each state has its own prompt and (optionally) allowed tools. 

2) Define transition logic 
Write clear, testable conditions inside the state’s prompt for when to move on. 

7. Ask if the user is interested in an in-person tour. 
   - if yes -> transition to schedule_tour 
   - if no/hesitant -> call end_call to politely hang up and say we’ll 
reach out if relevant properties appear 

3) Define when to call functions 
Tie tool calls to explicit confirmation steps. 

3. Confirm date, time, and timezone: “Just to confirm, you want ...” 
4. Once confirmed, call book_appointment to create the booking. 

 



Step 2 — Configure the Basic Settings 
Configure your agent’s core model, voice, and conversation behavior. 

Select a Language Model 
Start with GPT-4.1 for a strong balance of quality, latency, and cost. You can override the model 
per state later if needed. 

 

Configure Voice Settings 
1.​ Open the voice selection menu 
2.​ Preview voices and note the voice ID you prefer 
3.​ (Optional) Add custom voices from the ElevenLabs community​

 

 



 

Tip: Choose a voice that fits the brand and context (e.g., calmer for support, more energetic for 
sales). 

Set Who Speaks First 
●​ User-first: wait for the caller to speak​

Agent-first: agent opens (fixed welcome line or prompt-generated opener) 
●​ Optional “pause before speaking” to handle pickup delay on phone calls​

 

 



More Settings (tune as needed) 

Global Prompt 

Persona/guardrails that apply everywhere. This text is available to every node/state. 

Knowledge Base 

Attach documents, URLs, and snippets for domain knowledge. (See Knowledge Base Guide.) 

Speech Settings 

●​ Background sound – optional ambient audio to feel more human 
●​ Responsiveness – lower = slower replies (-0.1 ≈ +0.5s wait) 
●​ Interruption sensitivity – lower = more resilient to background chatter 
●​ Backchanneling – frequency/phrases for “mm-hm,” “got it,” etc. 
●​ Boosted keywords – bias recognition for brand names, people, etc. 
●​ Speech normalization – speak dates/currency/numbers naturally 
●​ Reminder frequency – how often to prompt inactive users 
●​ Pronunciation – custom guides for tricky words​

 

Call Settings 

●​ Voicemail handling – detect and decide what to do (see Handle Voicemail) 
●​ End call on silence – auto-hang after inactivity 
●​ Max call duration 
●​ Pause before speaking – small delay before agent’s first line (phone)​

 

Post-Call Analysis 

Set up later to extract insights/variables. (See Post-Call Analysis Overview.) 

Privacy & Webhook 

Opt-out sensitive data storage and configure webhooks for call events. 

Step 3 — Add Function Calling 
Turn your agent from “talks” to “does.” Functions let it transfer calls, book appointments, 
send SMS, hit your APIs, and more. 



Function Calling Overview 

What it is 

Function calling lets the LLM decide when to invoke tools, extracts parameters from the 
conversation, executes the tool, and then weaves the result back into the dialogue. 

Flow 

1.​ Agent decision → LLM detects a need (e.g., “book an appointment”). 
2.​ Parameter extraction → Pulls details from context (date, phone, name…). 
3.​ Function execution → AIFront Desk Pro calls your tool with structured args. 
4.​ Response handling → Result is spoken and/or used for the next step. 

Example payload 

{ 
  "function": "book_appointment", 
  "arguments": { 
    "date": "2024-03-15", 
    "time": "14:00", 
    "customer_name": "John Smith" 
  } 
} 

Learn more 

●​ OpenAI Function Calling Guide 
●​ Function Calling Tutorial (step-by-step) 

Common Use Cases 

Call Management 

●​ Transfer calls to humans or other departments/agents 
●​ End calls gracefully when appropriate 
●​ Press digits (DTMF) to navigate IVRs 

Business Operations 

●​ Book appointments with your scheduler 
●​ Check availability (calendars/inventory) 

https://platform.openai.com/docs/guides/function-calling
https://semaphore.io/blog/function-calling


●​ Process orders (create/modify/cancel)​
 

Data Integration 

●​ Retrieve info from CRMs, databases, external APIs 
●​ Update records with new details 
●​ Send notifications via email/SMS/push 

Configuring Tool Calls 

Where to configure 

In the agent detail page → Functions. 

 

Available Function Types 

1) Pre-built tools (zero-code) 

Tool Purpose Typical use 

End Call Gracefully terminate After task completion or on user 
request 



Transfer Call Route to a 
human/department 

Escalations, routing 

Press Digits Send DTMF tones IVR navigation, code entry 

Check Availability Query open time slots Scheduling 

Book Calendar Create calendar events Confirm meetings/appointments 

Send SMS One-way text Confirmations, follow-ups 

2) Custom functions (bring your own APIs) 

●​ Integrate any system (CRM/ERP/custom) 
●​ Execute business logic (validation, pricing, inventory) 
●​ Trigger external workflows​

 

Features 

●​ Flexible parameters 
●​ Optional async behavior 
●​ Error-handling and fallbacks 
●​ Full control over what the agent says during/after execution​

 

Pre-built Tools: How-tos 

End Call 

By default, calls aren’t auto-ended—configure explicit conditions. 



1) Add the tool​
 Functions → + Add → End Call​

  

2) Define termination conditions​
 Examples: 

●​ If the user says “thank you,” “goodbye,” or “bye,” end the call. 

​
 

3) Update your prompt​
 Tell the agent when to invoke the tool: 

●​ If the user says “thank you,” “goodbye,” or “bye,” use end_call to terminate the 
conversation. 



 

Transfer Call 

Works during phone calls only (AIFrontDesk Pro numbers & imported numbers). 

1) Add the tool​
 Functions → + Add → Transfer Call​

 

2) Configure basics 

●​ When to transfer (e.g., user is angry/requests a human) 
●​ Destination: E.164 number, SIP URI, or a dynamic variable 
●​ Optional extension 



​

​
 

3) Update your prompt 

If the user is angry or frustrated, use transfer_call to connect them to a human 
agent. 

 

 



4) Choose transfer type 

●​ Cold transfer — handoff and the AI disconnects 
●​ Warm transfer — detect human, play whisper/three-way messages, then bridge​

 

5) (Cold transfer) Caller ID options 

●​ Agent number (default) 
●​ Transferee’s number (requires provider support for SIP REFER + “transfer to PSTN” + 

caller ID passthrough)​

 ​
 

6) (Warm transfer) Options 

●​ On-hold music 
●​ IVR navigation prompt 
●​ Human detection (connect only when human) 
●​ Auto-greet on answer 
●​ Agent detection timeout (default 30s) 
●​ Whisper (private to recipient) 
●​ Three-way (both parties) 



​

 ​
 

7) (Optional) Custom SIP headers​
 Outbound SIP headers for routing/tagging/metadata.​
 All header names must start with X-.​

  

Send SMS 

One-way SMS from the agent’s number to the user’s number. Phone calls only. 



Requirements 

●​ Number must support SMS (currently AIFrontDesk Pro Twilio numbers). 
●​ Agent should tell the user an SMS is being sent when invoking this tool.​

 

Configure SMS content 

●​ Prompt-generated content, or 
●​ Static text (supports dynamic variables)​

 

 

 

Check Calendar Availability (Cal.com) 

Query open time slots for a Cal.com event type. 

1) Create a Cal.com account​
 Go to cal.com and sign up. 

2) Create an event type​
 Dashboard → Event Types → New → Configure → Save 

3) Get credentials 

●​ Event Type ID: open the event and copy the number at the end of the URL (e.g., 
.../event-type/1427703) 

●​ API Key: Settings → Developer → API Keys​
 



 

4) Add the “check availability” tool in AIFrontDesk Pro 

●​ Tool name (unique per agent) 
●​ Cal.com API Key 
●​ Event Type ID 
●​ Description (e.g., “Checks availability for 30-min consults”) 
●​ (Optional) Timezone override​

 Save​
 

5) Prompt tip​
 Tell the agent when to call the tool: 

When the user states a time range, call `check_calendar_availability` 
and confirm whether that range works. 

 

 

Best-practice Prompting for Tools 

●​ Be explicit about when to call which tool (“If X, call Y”) 
●​ Confirm parameters with the caller before executing (“Just to confirm, 3/15 at 2 PM?”) 



●​ Acknowledge results and guide the next step (success/failure paths) 
●​ Keep tools scoped in multi-prompt: only enable what each state needs 

Book Calendar 

Integrate Cal.com appointment booking with your AIFrontDesk Pro AI agent. 

Use this tool to let the agent book appointments directly on Cal.com. 

 

Prereqs 

1.​ Cal.com account → cal.com 
2.​ Event Type → Dashboard → Event Types → New → configure → Save​

 

Credentials you’ll need 

●​ Event Type ID: Open the event type and copy the number in the URL​
 Example: https://app.cal.com/your-username/event-type/1427703 → 
1427703 

●​ API Key: Cal.com Settings → Developer → API Keys​
 

Add the “book calendar” function in AIFrontDesk Pro 

●​ Tool name (unique per agent) 

https://cal.com


●​ API Key (Cal.com) 
●​ Event Type ID 
●​ Description (e.g., “Books 30-minute consults”) 
●​ (Optional) Timezone override​

 Save. 

Prompt guidance 

Tell the agent when to book: 

When the user selects a slot, call `book_appointment` to create the 
booking. 

Press Digit (IVR Navigation) 

Enable the agent to send DTMF tones to navigate IVR menus.​
Requires Call API v2. If you’re on an older version, see the migration guide. 

Some IVRs accept speech (prompt your agent to speak). Others require DTMF (digits). Use this 
tool for the latter. 

Steps 

1.​ Add the Press Digit tool​
 (Description is optional; you can document when/what to press.)​
 

 

2.​ Add prompt instructions​
 If IVR is unknown:​
 



You may reach an IVR. Listen carefully and press the correct digit to 
reach Support. 

If IVR is known: 

Press digit 1 to reach the Support department. 

3.​ Test​
 Place an outbound call to a known IVR, or simulate one yourself (e.g., “Press 1 for …”).​
 

Integrate Any System with Custom Function 

Extend your agent with your APIs for data lookups, updates, and custom logic. 

AIFrontDesk Pro will call your endpoint with structured arguments whenever the LLM decides 
the function is needed. 

Create a custom function 

1.​ Add the function​
 Functions → + Add → Custom Function. 

2.​ Configure details 
●​ Name (snake_case, unique) 
●​ Description (what it does) 
●​ HTTP method: GET, POST, PATCH, PUT, or DELETE 
●​ Endpoint URL (must be valid) 
●​ Headers (optional; static or dynamic) 
●​ Query params (optional; static or dynamic)​

 

 

 



3.​ Define parameters (POST/PATCH/PUT only)​
 Use JSON Schema or the JSON form.​
 

JSON Schema example 

{ 
  "type": "object", 
  "properties": { 
    "city": { 
      "type": "string", 
      "description": "City to fetch weather for" 
    } 
  }, 
  "required": ["city"] 
} 

4.​ Map response variables (optional)​
 Extract values from the API response into dynamic variables for later use.​
 

Example response 

{ 
  "properties": { 
    "user": { "name": "John Doe", "age": 26 } 
  } 
} 

Then reference later as {{user_name}}, etc. 

5.​ Configure speech behavior​
 

●​ Speak during execution — one short line at the start of the call (use for user-facing 
actions; disable for silent background tasks). 

●​ Speak after execution — continue speaking/acting once the call returns (usually 
enable; consider disabling for quick tasks like pressing digits).​
 

6.​ Prompt guidance​
 Make trigger conditions explicit:​
 



When the user provides a city, call `get_weather` and report the 
result. 

Troubleshooting 

●​ Save errors usually mean invalid parameter schema (most commonly missing "type": 
"object" at the top level). Start from an example and edit. 

Request & Response spec 

Request 

●​ Headers 
○​ X-Retell-Signature: HMAC of the request body using your secret (use it to 

verify requests are from AIFrontDesk Pro). 
○​ Content-Type: application/json​

 
●​ Body (for POST/PUT/PATCH) 

○​ name: function name 
○​ call: call object (includes real-time transcript). See Get Call API. 
○​ args: JSON object of parameters​

 

Timeout: your configured value, fallback 2 minutes. Retries: up to 2. 

Response 

●​ HTTP 2xx indicates success 
●​ Body can be string, buffer, JSON, or blob (will be converted to string for the LLM) 
●​ Result size cap: ~15,000 characters 

Verify requests​
 Use X-Retell-Signature to verify origin. (You can also IP allowlist 100.20.5.228.) 

Extract Dynamic Variables 

Parse the caller’s answers and store them as dynamic variables for logic and 
personalization. 

Steps 

1.​ Add the tool → Extract Dynamic Variable​
 



 

2.​ Add variables 
●​ Variable Name 
●​ Description 
●​ Type: Text, Number, Enum, Boolean 
●​ Enum options (if type is Enum) 

3.​ Save the tool​
 

4.​ Prompt guidance​
 Tell the agent when to extract: 

When the user states their name and phone number, call 
`extract_user_details`. 

Agent Transfer 

Switch the conversation from one AI agent to another without a phone transfer (Agent 
Swap). 

Why use Agent Transfer instead of Call Transfer? 

●​ Lower latency — near-instant state swap 
●​ More reliable — no new phone call, fewer telephony failures 
●​ No handoff script — destination agent sees full history 
●​ One phone number — no separate numbers for each agent​

 

Setting inheritance​
 The first agent’s settings that persist across the call: 

●​ optInSignedUrl 



●​ optOutSensitiveDataStorage 
●​ webHookUrl​

 

Other settings (language, voice, voiceModel) follow the current agent. 

Steps 

1.​ Add Agent Transfer tool​
 Functions → + Add → Agent Transfer​

​
 

2.​ Configure details 
●​ Transfer agent — target agent ID and version (or latest) 
●​ Speak during execution — optional messages during the swap 
●​ Post-call analysis — extract variables for the transferred agent only, or both​

 

 

3.​ Prompt guidance​
 Be explicit about when to swap: 



If the user asks to book an appointment, use `agent_transfer` to 
switch to the Appointment Agent. 

 

4.​ Test & debug​
 Test from web call or playground to confirm the swap behavior.​

 

 

 



Set Language for Your Agent 
The Language setting determines how your agent hears and speaks.​
 It affects: 

●​ ASR language — controls transcription language and accent recognition. 
●​ Default TTS model & language code — sets the base voice output. 
●​ Speech normalization — refines pronunciation and formatting (e.g., numbers, dates).​

 

🟢 Note: This setting does not lock the agent’s reply language or accent. You can override 
those through the prompt and by selecting a specific voice. 

●​ For full coverage (including multilingual and code-switch modes), check the Supported 
Languages list in your dashboard. 

●​ Developers can also define the language via the API using the language field in 
Create/Update Agent. 

 



Balance Between Transcription Accuracy & 
Latency 
AIFrontDesk Pro offers two real-time modes for ASR-to-LLM flow: 

Mode Behavior Best for 

Speed Lowest latency; streams partial transcriptions 
quickly. 

Conversational agents where flow 
matters more than precision. 

Accuracy Waits ~200ms more before sending; captures 
entities (names, dates, digits) more reliably. 

Task-heavy agents that depend on 
structured input. 

WER (word error rate) stays roughly the same; the main trade-off is speed vs. reliability of 
entities. 

 

Choose a Custom Voice 
Personalize your agent’s tone with custom voice cloning: 

●​ Add up to 100 custom voices (limit can be increased by request). 

 



●​ ElevenLabs → Community voices + Voice cloning. 
●​ Cartesia → Voice cloning support. 

 

 

●​ Upload short, clear voice samples to train your clone. 
●​ You can also reference existing ElevenLabs voices by name for quick setup. 

​

 



Make the Agent Hold or Stay Silent 
Sometimes, you want the agent to pause or stay silent instead of responding. 

Use the special token: 

NO_RESPONSE_NEEDED 

Include it in your prompt logic: 

●​ If the user says “hold on,” output exactly NO_RESPONSE_NEEDED. 

This keeps the session open while pausing output. 

TTS Fallback (Speech Continuity) 
The fallback system ensures your agent keeps speaking even if a TTS provider fails. 

●​ Automatically switches to a similar voice (gender/tone). 
●​ Cascades across available providers until stable. 
●​ Once a fallback is used, the agent stays on it for call consistency. 
●​ You can define your own multi-provider fallback list (AIFrontDesk Pro & Play voices 

supported). 

 

 



Handle Voicemail Detection 
Your agent can automatically detect voicemail and react accordingly. 

●​ Detection adds less than 100ms latency. 
●​ Detection window lasts up to 3 minutes per call. 
●​ Behavior options: 

○​ Hang up immediately, or 
○​ Leave a message (static text or dynamic prompt). 

●​ When looping messages or silence occurs, the system will still hang up gracefully. 
●​ Messages are left only when it’s the agent’s turn to speak. 

 

 

Knowledge Base 
The Knowledge Base (KB) helps your agent access external information — from documents, 
web pages, or text snippets — to provide accurate and context-rich responses during a 
conversation.​
It’s ideal for support, helpdesk, or FAQ-based agents, where detailed reference material is 
essential but too long to fit directly in the prompt. 

How It Works 

When you link a knowledge base to an agent, it automatically searches for relevant information 
before generating every response — no extra prompt setup is needed. 

Here’s what happens under the hood: 



1.​ All added sources (URLs, documents, or text) are chunked, embedded, and stored in 
a vector database. 

2.​ During a live call, the system uses the conversation transcript to retrieve the most 
relevant chunks. 

3.​ Retrieved content is sent to the LLM under the section:​
​
 ## Related Knowledge Base Contexts 

 

Supported Sources 

Your knowledge base can include: 

●​ 🌐 Websites (URLs) — Optionally auto-refreshed or auto-crawled daily for updates 
●​ 📄 Documents — Supports common file types (PDF, DOCX, TXT, XLSX, MD, etc.) 
●​ ✏️ Custom Text Snippets — Add quick notes, FAQs, or domain-specific facts 

​

 

 



Auto-Refresh & Auto-Crawl 

You can enable Auto-Refresh or Auto-Crawl for URL-based sources: 

●​ Auto-Refresh → Updates existing URLs every 24 hours 
●​ Auto-Crawl → Crawls all subpages within a defined path automatically​

Excluded URLs can be managed via an exclusion list 

​

 

 

 

 

 



Best Practices 

To ensure accurate retrieval: 

●​ Use Markdown (.md) files when possible — structured headers and short paragraphs 
improve accuracy. 

●​ Avoid vague pronouns or long, unstructured text blocks. 
●​ Keep related content within the same section for cohesive retrieval. 
●​ Use clear headings (##, ###) and specific phrasing (include names, dates, etc.). 
●​ Do not include instructions or prompts — only reference material.​

 

Linking to Your Agent 

Once a knowledge base is ready: 

1.​ Go to your Agent Editor. 
2.​ Open the Knowledge Base tab. 
3.​ Select which KB items to attach to the agent. 
4.​ Adjust retrieval settings: 

○​ Chunks to Retrieve: 1–10 (Default 3) 
○​ Similarity Threshold: 0.6 recommended 

 



 

Node-Level Knowledge Base 

In Conversation Flow Agents, you can assign knowledge bases to specific conversation 
nodes for better topic-level accuracy.​
 Node-level KBs are combined with the global KB to improve contextual relevance for that 
node’s dialogue. 

 

Quick Tips 

●​ You don’t need to modify prompts — KB works automatically. 

You can restrict the model’s responses using a simple rule like:​
​



Only answer using the information in ## Related Knowledge Base 
Contexts. 
If missing, respond: "There is no related information in the knowledge 
base." 

●​ Retrieval latency is optimized — typically adds under 100ms.​
 

Pricing Overview 

●​ First 10 knowledge bases: Free 
●​ Extra knowledge bases: $8/month each 
●​ Usage fee: $0.005/min for calls with KB enabled (regardless of KB count) 

Dynamic Variables 
Use dynamic variables to personalize responses and control data flow across calls. 

Where you can use them 

●​ Prompts 
●​ Begin Message 
●​ Function URLs/descriptions 
●​ Voicemail messages 
●​ Transfers 
●​ Webhook URLs 

How to use 

Variables are written as: 

{{variable_name}} 

You can set default values at the agent level, or pass them per call via API or webhook (only 
strings are supported). 

System variables include 

●​ {{current_time}} 
●​ {{session_type}} 
●​ {{caller_id}} 



●​ {{agent_id}}​
 Supports nested variables for complex references. 

If a variable is missing, it renders literally ({{var}}).​
Use default fallbacks or conditional prompting to avoid unexpected placeholders. 

Test 
Quick ways to validate agents before launch — what each method is best at, and when to 
use it. 

Methods 

1) LLM Playground 

Use for: fast iteration & prompt/debug cycles.​
You get: live convo testing, function-call trace, variable view, prompt tweaks.​
Best when: starting out, reproducing edge cases, tuning tools. 

 



2) LLM Simulation Testing 

Use for: repeatable QA at scale.​
You get: batch runs, success metrics/scoring, scenario templates, regression gates.​
Best when: pre-release checks, CI-style guardrails. 

 

3) Web / Phone Call 

Use for: real audio + telephony.​
 You get: latency/voice quality checks, barge-in/interrupt handling, background noise, DTMF.​
 Best when: final production readiness. 



 

Quick Comparison 
 Playground Simulation Web/Phone 

Setup Medium Low High 

Availability All Agents All Agents All Agents 

Speed Fast Very fast Real-time 

Batch tests ❌ ✅ ❌ 

Response accuracy ✅ ✅ ✅ 

Tool calls view ✅ ✅ ✅ 

Noise/interrupts ❌ ❌ ✅ 

Cost Free Free Call fees 

Recommended Flow 
1.​ Dev: Playground to refine prompts, tools, variables. 
2.​ QA: Simulation to lock scenarios, add regression tests + metrics. 



3.​ Pre-launch: Web/Phone for real-world audio + telephony. 
4.​ Ongoing: Scheduled Simulation runs to catch regressions. 

Deploy 

Purchase phone number 
Buy and manage a US number in AIFrontDesk Pro; bind agents; test quickly. 

From Dashboard 

●​ Go to Numbers → Purchase; optionally pick area code(s). 
●​ After purchase: rename the number for easy identification. 
●​ Assign an Inbound Agent to start receiving calls immediately; place a quick test call.​

 

 

 

From API 

●​ Use Create Phone Number API to buy and bind agents programmatically. 
●​ Numbers remain yours; list them via List Phone Numbers.​

 



●​ You can set different inbound/outbound agents or keep inbound_agent_id unset 
to block callbacks.​
 

# Purchase a phone number 
 
phone_number = client.phone_number.create( 
  inbound_agent_id="oBeDLoLOeuAbiuaMFXRtDOLriTJ5tSxD", # replace with the agent id you 
want to assign 
  outbound_agent_id: "oBeDLoLOeuAbiuaMFXRtDOLriTJ5tSxD", # replace with the agent id you 
want to assign 
) 
print(phone_number) 
 

Pricing (managed numbers) 

●​ Twilio: US $2/mo, Toll-free $5/mo, Canada $2/mo. 
●​ Telnyx: US $2/mo. 

Toll-free inbound: $0.06/min; outbound same as US numbers. 

Custom Telephony  
Connect your own provider via Elastic SIP Trunking (recommended) or Dial to SIP URI. 

What you need 

●​ AIFrontDesk Pro SIP server: sip:sip.retellai.com 
●​ US IP ranges to whitelist: 143.223.88.0/21, 161.115.160.0/19 
●​ Transports: UDP/TCP/TLS (append ;transport=). Media: SRTP.​

 

Method 1 — Elastic SIP Trunking (Best) 

●​ Create a trunk with your provider → set Termination (outbound) + Origination (inbound 
→ sip:sip.retellai.com).​
Move numbers to the trunk → Import them into AIFrontDesk Pro(provide termination 
URI; add auth creds if used). 

●​ Then they behave like AIFrontDesk Pro-managed numbers (calls, dashboard, APIs). 



●​ Help: Use partner Jambonz if you require static IP / mTLS.​
 

FAQ highlights 

●​ AIFrontDesk Pro can’t pre-validate configs; test with a call. 
●​ Inbound issues: check origination; outbound: check termination + credentials. 
●​ SIP REFER transfers require enabling in your provider.​

 

Method 2 — Dial to SIP URI 

●​ You run telephony; AIFrontDesk Pro handles the agent over SIP. 
●​ Call Register Phone Call API → get call_id → dial 

sip:{call_id}@sip.retellai.com. 
●​ You own transfer/end-call logic (AIFrontDesk Pro transfer feature not available).​

 

Twilio via SIP Trunking  
Step-by-step to connect your Twilio trunk and import numbers into AIFrontDesk Pro. 

Steps 

1.​ Create Trunk 
●​ Name it; note a localized Termination URI (region-near). 
●​ Auth: use credentials (supply to AIFrontDesk Pro on import) or ACL IPs (use full 

ranges).​
 



 

 



 
 

2.​ Origination (Inbound)​
 

●​ Set Twilio Origination URI to sip:sip.retellai.com. 

 

3.​ Move Numbers to Trunk​
 

●​ Purchase/assign numbers to the trunk. 

 
 



4.​ Import to AIFrontDesk Pro​
 

●​ In AIFrontDesk Pro: Import Number → paste Termination URI (+ username/password 
if used). 

●​ After import, place inbound/outbound calls from the dashboard or Create Phone Call 
API.​
 

 

 
 

Common Issues (Quick Fix) 

●​ Outbound fails: use localized Termination URI; remove spaces; verify actual username 
(not friendly name) + password. 

●​ International dialing: enable Voice Geographic Permissions → Elastic SIP Trunking 
→ select countries. 



 

Phone Number Masking (Caller ID) 

●​ Add a Verified Caller ID in Twilio → OTP verify. 
●​ On your trunk: Header Manipulation Policy → Request rule:​

 SIP header: From number → Action: Replace with → Value: +E164. 
●​ Apply policy on Termination; test an outbound call.​

 

 

 
 

 



International Calling and Fees 
Make global calls and manage international rates directly from your AIFrontDesk Pro 
dashboard. 

Overview 
AIFrontDesk Pro supports both domestic (US) and international calling, allowing your agents 
to connect with users worldwide.​
You can also purchase international phone numbers to provide a local presence for your 
customers in other countries. 

📘 See Purchase Number for how to buy and link numbers. 

Supported Providers and Rates 

Twilio 

🌍 Country 💬 Rate/Min 

🇺🇸 US $0.015 

🇺🇸 US (Toll-Free) $0.06 

🇮🇳 India $0.15 

🇦🇺 Australia $0.10 

🇩🇪 Germany $0.10 

🇪🇸 Spain $0.10 

🇬🇧 UK $0.10 

🇲🇽 Mexico $0.05 

🇫🇷 France $0.06 

🇯🇵 Japan $0.28 

🇨🇦 Canada $0.03 



🇮🇹 Italy $0.06 

🇮🇩 Indonesia $0.40 

🇵🇭 Philippines $0.80 

🇲🇾 Malaysia $0.20 

🇹🇭 Thailand $0.45 

Notes 

●​ Prices are subject to provider updates — always verify current rates on your 
provider’s dashboard. 

●​ AIFrontDesk Pro uses your chosen telephony backend (Twilio or Telnyx) for rate 
calculation. 

●​ Inbound toll-free calls are typically charged at a higher rate. 
●​ Outbound calls to unsupported destinations will return an error message.​

 

AIFrontDesk Pro Website Widget 
Easily embed interactive chat or callback widgets powered by your AIFrontDesk Pro 
agents. 

Overview 
The AIFrontDesk Pro Website Widget lets you add conversational AI directly to your website 
with a single script. It’s secure, customizable, and uses AIFrontDesk Pro’s public key 
system—meaning no backend proxy is required. 

The widget supports two main modes: 

●​ Chat Widget – Text-based chat powered by your chat agent 
●​ Callback Widget – Collects user info and triggers a phone call through your voice agent​

 



 

Prerequisites 

Before embedding: 

1.​ Create an agent 
○​ Chat Widget → Create a chat agent 
○​ Callback Widget → Create a voice agent​

 
2.​ Gather credentials​

 
○​ AIFrontDesk Pro Public Key 
○​ Agent ID (chat or voice) 
○​ AIFrontDesk Pro phone number (for callback mode)​

 

Chat Widget 

The chat widget allows real-time text-based conversations. Embed it with a single <script> 
tag in your webpage. 

Example Setup 
<script 
  src="https://dashboard.retellai.com/retell-widget.js" 
  type="module" 
  data-public-key="YOUR_AIFrontDesk Pro_PUBLIC_KEY" 
  data-agent-id="YOUR_CHAT_AGENT_ID" 



  data-title="Chat with us!" 
  data-color="#FFA07A" 
  data-logo-url="YOUR_LOGO_URL" 
  data-bot-name="AI Assistant" 
  data-popup-message="Hi there! Need help?" 
  data-show-ai-popup="true" 
  data-recaptcha-key="YOUR_RECAPTCHA_SITE_KEY"> 
</script> 
 

Key Attributes 

Required 

●​ data-public-key – Your AIFrontDesk Pro public key 
●​ data-agent-id – The chat agent’s ID​

 

Optional 

●​ data-title, data-logo-url, data-color – Customize branding 
●​ data-popup-message, data-show-ai-popup – Control popup prompts 
●​ data-recaptcha-key – Enables reCAPTCHA v3 for bot protection​

 

Callback Widget 
The callback widget lets users request a phone call directly from your site. It collects their 
details and triggers a call using your AIFrontDesk Pro voice agent. 

Example Setup 
<script 
  src="https://dashboard.retellai.com/retell-widget.js" 
  type="module" 
  data-widget="callback" 
  data-public-key="YOUR_AIFrontDesk Pro_PUBLIC_KEY" 
  data-agent-id="YOUR_VOICE_AGENT_ID" 
  data-phone-number="+15551234567" 
  data-title="Request a Call" 
  data-countries="US,CA,GB" 



  data-color="#FFA07A" 
  data-tc="https://yourdomain.com/terms" 
  data-recaptcha-key="YOUR_RECAPTCHA_SITE_KEY"> 
</script> 
 

How It Works 

1.​ User clicks the phone icon 
2.​ A form appears asking for name, phone, and consent 
3.​ reCAPTCHA validates submission (if enabled) 
4.​ AIFrontDesk Pro API triggers an outbound call from your number 
5.​ Your voice agent answers the call and handles the conversation​

 

Widget Summary 

Feature Chat Widget Callback Widget 

Interaction type Text-based chat Phone callback 

Agent type Chat agent Voice agent 

reCAPTCHA support ✅ ✅ 

Customization Colors, title, logo Title, color, country list 

Setup complexity Easy Moderate 

 

Monitor 

Monitor Sessions via Dashboard 
View, analyze, and manage all your agent sessions — calls and chats — from a single 
unified dashboard. 

Overview 

The Session History Dashboard provides a complete view of every interaction handled by 
your agents.​



From here, you can track session outcomes, monitor performance, and review specific call or 
chat details. 

To access: 

1.​ Open your AIFrontDesk Pro Dashboard 
2.​ Select Call History or Chat History from the sidebar 

 

Filtering Sessions 

Use filters to quickly locate relevant sessions.​
 You can narrow results by: 

●​ Status (e.g., completed, failed, ongoing) 
●​ Agent 
●​ Date range 
●​ Duration 
●​ Customer identifier 

💡 When debugging, filtering for failed or incomplete sessions helps identify trends and 
troubleshoot issues efficiently. 

Customizing Columns 

Personalize your table view to display the most relevant information. 

1.​ Click Customize Field (top-right corner)​
 



2.​ Enable or disable columns like:​
 

○​ Agent ID 
○​ Caller info 
○​ Duration 
○​ Session status 
○​ Cost or latency metrics 

Each user’s column preferences are saved automatically for convenience. 

Additional Insights 

●​ Access detailed session transcripts or audio recordings directly from each record 
●​ Export filtered session data for reporting or auditing 
●​ Identify recurring issues using visual trends in session statuses​

 

Accounts and Workspace 

API Key Overview 
Authenticate and secure all your API and webhook requests using API keys. 

Overview 

API keys are essential for authenticating requests to AIFrontDesk Pro’s APIs and SDKs. They 
ensure secure communication between your application and the AIFrontDesk Pro platform.​
 Each workspace can maintain multiple API keys, all sharing the same permission level, 
allowing for organized key management across environments (e.g., staging vs production). 

API keys are used for: 

●​ REST API endpoint access 
●​ SDK integrations 
●​ Webhook signature validation​

 

REST API Authentication 

To authenticate your REST API calls, include your key in the Authorization header: 



Authorization: Bearer YOUR_API_KEY 
 

You can test your authentication setup using the API Playground, which allows you to verify 
credentials and request flow interactively. 

Webhook API Key 

For added security, AIFrontDesk Pro automatically assigns one of your API keys as the 
Webhook Key.​
 This designated key is used to sign and verify incoming webhook requests, ensuring that 
your application only processes legitimate calls from AIFrontDesk Pro servers. 

Key properties: 

●​ Automatically selected during setup 
●​ Cannot be deleted 
●​ Used exclusively for webhook verification 

Note: Keep your API keys secure. Never share them in public repositories, client-side code, or 
unsecured environments.  

Manage API Keys 
Create, delete, and manage API keys directly from your AIFrontDesk Pro dashboard. 

Managing Keys 

In your System Settings → API Keys section, you can perform the following actions: 

1.​ Create a new API key 
○​ Click Add 
○​ Assign a descriptive name to help identify its purpose (e.g., “Production Voice 

Agent”)​
 

2.​ Delete an API key 
○​ Locate the key you wish to remove 
○​ Click the 🗑️ delete icon 
○​ Confirm the action — note that deleted keys cannot be recovered​

 
3.​ Set a Webhook API key 

○​ Choose an existing key​
 



○​ Click Set as Webhook Key 
○​ Only one key can hold this role at a time​

 

Note: If a key is ever compromised, delete it immediately and create a replacement to prevent 
unauthorized access. 

 

Public Keys 
Used for securely embedding AIFrontDesk Pro widgets on websites. 

Overview 

Unlike API keys, Public Keys are designed for safe, client-side usage — primarily with the 
AIFrontDesk Pro Chat Widget.​
They enable secure frontend integration without requiring a backend proxy. 

Public keys are only used for: 

●​ Embedding chat or callback widgets 
●​ Authorizing public widget API calls​

 



 

Allowed Domains 

For security, public keys are restricted to specified allowed domains.​
This prevents unauthorized use on unapproved sites. 

To configure allowed domains: 

1.​ Open Public Keys in your dashboard 
2.​ Click the desired key 
3.​ Add the domains you control (e.g., example.com, app.example.com) 
4.​ Click Save 

Google reCAPTCHA v3 Protection (Optional) 

To prevent abuse or spam, AIFrontDesk pro supports optional Google reCAPTCHA v3 
integration for public keys.​
 When enabled, reCAPTCHA validation is performed before initializing any chat session. 

To enable: 

1.​ Go to the Public Keys dashboard section 
2.​ Select your public key 
3.​ Enable Abuse Prevention (Google reCAPTCHA) 
4.​ Add your reCAPTCHA secret key (from Google’s reCAPTCHA portal) 
5.​ Adjust the Score Threshold (default: 0.5) 

○​ Lower = more tolerant 

https://www.google.com/recaptcha


○​ Higher = stricter validation​
 

Note: If you enable reCAPTCHA, ensure it’s also implemented in your frontend. See [Google’s 
documentation](https://developers.google.com/recaptcha/docs/v3) for details.  

Security Best Practices 

Even though public keys are safe for frontend use, follow these precautions: 

●​ Restrict keys to domains you own 
●​ Review your allowed domain list periodically 
●​ Use the lowest necessary permissions 
●​ For backend communication, always use API keys instead of public keys 

Managing Public Keys 

To manage public keys in your dashboard: 

1.​ Navigate to Public Keys 
2.​ Create a new key or select an existing one 
3.​ Configure allowed domains 
4.​ (Optional) Enable Google reCAPTCHA 
5.​ Copy your key for widget embedding 
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